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Finding data
There are a number of functions that help you 
to find data in a spreadsheet. One of the most 
commonly used ones is the filter function that 
extracts all instances of records that contain the 
chosen filtering term, numbers or range.

In this example, we want to extract all items that 
have a price in a given range. 

We begin by selecting the heading cells of 
the data, clicking on the Data tab, then on the 
Filter icon. This will activate the AutoFilter 
(Figure 42.64).

We will then need to choose the values we want 
to display. To do this you would need to click 
on the Filter icon to the right of Resale Price. 
Clicking on Number Filters will then let you 
choose the criteria (such as a range with a maxi-
mum and minimum value), on which to filter 
(Figure 42.65).

42.2.5 Refine
This section will cover the following grading 
criterion: 

M1

Activity 2

Functions

There is a wide range of pre-
written functions that can be used 
within a spreadsheet and some of 
this functionality has already been 
considered.

Create a table that names at least 
five text functions and five statistical 
functions, identifies their function  
type (e.g. text or statistical) and 
provides a brief description of what 
the function does.

Keep an electronic copy for reference.

Figure 42.65  Custom Filter

Make the Grade
Showing that you can refine your spreadsheet 
is essential to achieve M1. You will need to 
demonstrate that you have improved the efficiency 
of your solution.
	 This could be achieved by the addition of 
shortcuts or other methods to aid navigation, as 
well as improving the presentation of your solution 
by adopting consistent and appropriate formatting 
techniques and styles.
	 Ultimately you must show that you have 
considered the development of your spreadsheet and 
that you can make it presentable and user friendly.

M1

Figure 42.64  Filter
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Refining a spreadsheet is essential to meet the 
Merit criteria in this unit. In order to do this you 
will have to show that you can improve the effi-
ciency of your spreadsheet, format the data cor-
rectly and show that you can print selectively.

Improving efficiency
Shortcuts
Efficiencies can be made in a number of areas 
including adding shortcuts (e.g. a button with a 
macro to print three copies of a particular area of 
the spreadsheet, rather than have to highlight the 
area and select to print three copies through the 
usual dialogue boxes).

This macro could then be placed on a button so 
that as the figures are changed, the user would have 
the option to print the same area again and again.

Aiding navigation
There are also a range of options that can be used 
to aid navigation around the spreadsheet. For ex-
ample, cells can be locked to restrict the cells that 
the user can actually access (so using the tab key 
between cells moves to the next unlocked cell) – 
this is covered in more detail later in the unit.

Developers should also consider the input order 
for data to ensure that it is reflective of wherever 
the data is coming from. For example, there is little 
point in ordering the spreadsheet input boxes as 
shown in Figure 42.66 in preparation for data in-
put if the data, when received, is ordered as shown 
in Figure 42.67.

Formatting
Professional spreadsheets reflect professionalism 
in their formatting and the way that they look to 
the reader. This is achieved through a range of for-
matting options, which are briefly explored here 
(although there are many others if you experiment).

Fonts
The key with fonts is not only the choice of font 
but also in being consistent with the use of the 
fonts (all headings in the same font, the main body 
of the text in the same font etc.).

Fonts come in two main types:

Serif		  Fonts with small embellishments 

Sans serif	 Fonts without any embellishments 

Sub Macro1()
Macro1 Macro
Macro recorded 20/07/2010 by Bernie
    Range(“A1:A7,B3:B7”).Select                                 
‘Choose these ranges
    Selection.PrintOut Copies:=3, 
Collate:=True            ‘Print three 
copies
End Sub

Figure 42.66  Input screen

Figure 42.67  Source data
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Serif
Fonts with small 
embellishments

Figure 42.68  A font with serifs
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‘Sans’, as you may be aware, is French for ‘without’, 
so sans serif literally means ‘without serifs’. Some 
studies have indicated that text written in sans 
serif fonts is considered to be less formal and aids 
reading and recollection.  

Figure 42.69 shows some examples. To be able to 
see the difference clearly, look at the capital T in 
each example.

In addition, fonts are classified as proportional or 
non-proportional.

A proportional font uses up a different amount 
of space for each character – for example, an ‘I’, 
which is tall and thin would take up much less 
space than an ‘M’ (see Figures 42.70 and 42.71 for 
comparison).

In each case state whether the font is 
proportional or non-proportional.  

Keep an electronic copy for reference. 

Page orientation
Paper can be used in two different ways (this is 
called its orientation): landscape and portrait 
(Figure 42.72).

 

Charts and graphs are often created in landscape 
view, particularly bar charts and trend charts, 
to ensure that the image is as clear as it can be. 
Printing on paper in the same landscape orienta-
tion will ensure that the information is fully leg-
ible. Squashing it into a portrait view could make 
some or all of the information illegible.

Header and footer
Just as with Microsoft Word® documents, spread-
sheets can be enhanced with headers or footers. 
A header appears in the white space at the top of 
a document or spreadsheet; a footer appears in 
the white space at the bottom. Inserting these is 
an option on the Insert tab, on the Text menu (see 
Figure 42.73).

Figure 42.69  Fonts

Figure 42.70  Times New Roman

This font is Courier New (14) and it is a serif,
non-proportional font as it uses the same amount
of space for an 'I' as it does for an 'M'. This

Figure 42.71  Courier New

Activity 3

Fonts

Investigate different font examples and 
identify five serif and five sans serif 
fonts.

42_77 BTEC_L3_Nat. IT
Barking Dog Art

Landscape Portrait

Figure 42.72 

Figure 42.73  Header and footer



Spreadsheet modelling

403

Activating the Text menu brings up an additional 
tab (in this case the Design tab), which contains 
an extensive list of header and footer options. If 
you have chosen to insert a header, the Header 
box appears and the cursor flashes for text entry.

Print area
There will be instances where the user does not 
wish to print an entire spreadsheet, but instead 
decides to print a part of it. To do this, you need to 
highlight the area you want to print, then click on 
the Page Layout tab and the Print Area option. 
You can then set or clear a series of selected cells.

Use of colour
Colours can also be used to improve the appear-
ance of the spreadsheet. In the example in Figure 
42.76, we have changed the colour of the row and 
column headings and have also used a different 
colour to highlight the highest sales value for each 
region over the period.  You can clearly see that 
the Midlands, South West and North had their 
best month in January, while for the South East it 
was February.

42.3 Be able to automate and 
customise spreadsheet models
This section will cover the following grading 
criteria: 

P4
  

M2

42.3.1 Sorting and summarising 
data
Use of sub-totals and facilities 
A pivot table is a tool that can be used to summa-
rise a data set and allow the data users to see the 
data from different perspectives.

Using the data in Figure 42.77, we will use the piv-
ot table facility to provide subtotals and different 
views of the data.

Figure 42.74  Header and Footer Tools

Figure 42.75  Setting the print area

Figure 42.76  Colours

Make the Grade
More practical use of a spreadsheet, P4 requires 
you to create charts and graphs from numeric data 
sets. This can be either the same data used to create 
different graphical images, or a number of different 
charts or graphs created from different data sets.  
You must make sure that your graphs and charts are 
fit for purpose and that they have appropriate titles, 
labels, axis scales and suitable colours, and that the 
chart or graph is of an appropriate type. 
	 For M2 you will need to use the graphs or charts 
you have developed for P4 as a method of analysing 
and interpreting data from your spreadsheet model. 
	 As an alternative you could be asked to use 
sub-totals or pivot tables, data sorting and data 
comparison (trends for example) techniques to 
analyse data. 
	 Ultimately to achieve M2 you will need to 
demonstrate that you are using these techniques 
as appropriate to the situation to interpret the 
spreadsheet model. 

M2P4
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Sorting data on multiple fields
The key issue with sorting data is ensuring that 
you select all the data across the rows and columns 
to be included when the records are moved. Failure 
to do this could result in data becoming mixed up 
and effectively useless.

In Figure 42.80 (on the next page) the data had 
been sorted in date order. We will now use the same 
data and sort it on multiple fields. See Activity 5 
for details.

Filtering data sets 
With sorted or unsorted data there is also an 
autofilter Function. To activate the autofilter, 
highlight the headings at the top of the relevant 
data, click on Data and then on the Filter icon. 
The column headings will automatically become 
drop-down boxes. Selecting the drop-down menu 
beside Description, for example, will allow the user 
to choose which item to display and it will extract 
only those records from the list which match your 

Activity 4

This activity will walk you through the 
creation of a pivot table.

Sorting data on multiple fields
1	 To begin you will need to open a new 

spreadsheet and key in the data as 
shown below. 

Figure 42.77  Purchase data sorted by date only

2	 To analyse the data we will now 
use the pivot table functionality. To 
access this we click on Insert, then on 
PivotTable (see Figure 42.78).

Figure 42.78  Accessing the functionality

Having clicked on OK you now see a 
different dialogue box. 

Figure 42.79  PivotTable dialogue box

3	 You now drag and drop the fields 
you need in your pivot table over the 
spreadsheet. 

In this example we want to analyse 
what was purchased from each 
supplier, so we will choose the Supplier, 
Description and Quantity data items.

Figure 42.80  The pivot table results

As with other spreadsheet tables, pivot 
tables can also be filtered, sorted and 
manipulated.
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selection. To demonstrate this function, we click 
on Description, as suggested, and then deacti-
vate the Select All option in the list and click only 
Assorted Band Logos (Figure 42.84).

The filtered list now shows only those suppliers 
from whom Kris Arts and Media have purchased 
that particular product. Notice that the drop-
down icon on the Description column has now 
changed to a Filter icon. This is very useful to the 
user as he or she can immediately see where a fil-
ter has been applied (Figure 42.85).

Similarly, you could choose to filter for all the 
records for one particular supplier or for goods 
purchased on a single date. Usefully, the autofilter 
function can be switched on or off on demand.

Figure 42.84  Using the autofilter to filter data

Figure 42.85  Autofilter results

Activity 5

This activity will walk you through 
sorting data on multiple fields.

1	 Using the same data as created for 
the previous activity, highlight the 
area to be sorted (this is all the data 
excluding the headings).

Figure 42.81  The data area

2	 We will now sort by Supplier and 
then Description. To do this we will 
activate both options simultaneously. 
We now click on Data menu then on 
Sort to bring up the sorting dialogue 
box, which appears as shown in 
Figure 42.82.

3	 From the drop-down list choose to 
Sort by Supplier name then click to 

Add Level and select Then by and 
choose Description.

Figure 42.82  The sort interface

Once you have clicked on OK you will 
see the sorted list as shown in Figure 
42.83.

Figure 42.83  The sorted list



BTEC Level 3 National in IT

406

Using these features and facilities will enable you 
to produce professional spreadsheets that meet 
user needs. If in doubt about what is required on a 
spreadsheet or how the audience requires the data 
presented – ASK!

42.3.2 Tools
Charts and graphs
Being able to create charts and graphs is an im-
portant skill for anyone working with data through 
spreadsheets.  

Using another pivot table, prepared to show the 
items purchased and the quantities as totals only, 
we now create a column chart.

When you use the data in a pivot table to create 
the chart or graph, once the Wizard has been used 
to create the base chart (in the first instance a col-
umn chart), the interface is slightly different as it 
offers you the pivot table choices as menus and 
buttons which means you can easily change which 
pieces of data are used to make up the chart or 
graph (see Figure 42.86). The user can now draw 
conclusions based solely on the information in the 
chart – for example: long-sleeved T-shirts have not 
been purchased from Kavana Shirts (there is no 
pink or purple column against this supplier).

As always, the title will need to be added, labels 
will need to be included or removed as required, 
the X-axis (across) will require a title (in this case 
Supplier Name) and the Y-axis (up and down) will 
require a title, which in this instance could be 
Quantity Purchased.

Similarly, as with all charts, an appropriate general 
title will be required.

In all charts created in Microsoft Excel® the chart 
area can be formatted and the background col-
ours changed. Similarly, annotation can be added.

Select appropriate chart type for data type 
A range of chart types exist, some of which will now 
be explored.

Pie charts 
Pie charts are generally used where you want to 
represent data visually as part of a whole. Had we 
chosen a pie chart instead of a column chart in 
Figure 42.86, each column would have been rep-
resented by a slice of the pie. The larger the slice, 
the more it represents of the whole.  

The pie chart you will see most often when work-
ing with computer systems is in the properties of a 
destination drive (such as your hard disk or a flash 
memory device) (see Figure 42.87).

Column charts 
As shown in Figure 42.86, column charts contain 
vertical bars (upright). This is probably the most 
commonly used chart type and is usually offered as 
the default (or first choice) by the Wizard. Column 
charts are useful for allowing users to visually 
compare columns of data.  

Bar charts 
With horizontal bars (flat), bar charts are often 
used for comparing distances, for example.  Many 
people, however, use the term “bar chart” regard-
less of whether the bars are vertical or horizontal.

Line graphs 
Line graphs are good for comparing trends, as 
with the spreadsheet included at the beginning of 
this unit.

Figure 42.86  A chart made from a pivot table

Figure 42.87  Pie chart used to display free and used 
disk space 
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When using any chart or graph, users must make 
certain that the chart will actually mean some-
thing to the data user. Consider the pie chart in 
Figure 42.89. What is it telling you?

In fact, this pie chart is not very useful. As it has no 
title and no key or legend, the user is unlikely to 
understand what it is actually intended to present! 

This is a very common error made by users in cre-
ating such charts.

Justify choices
When creating charts and graphs, be prepared 
to explain your choices to users or managers. To 
avoid errors in this respect, always make sure you 
fully understand what you are trying to achieve in 
using this medium to present information. 

42.3.3 Presenting
Combining information 
Professionally presented information is usually 
a combination of tables of data or information, 
charts or graphs and textual commentary that ex-
plains the images. In some cases, the images are 
used to provide a better understanding of the text.

Using combined information to support arguments 
will become easier with experience. As a general 
rule, always try to provide evidence to support both 
sides of an argument before drawing a conclusion.

Maintaining data 
This topic has already been covered in section 
42.1.1 earlier in this unit.  

You should just remember that any links estab-
lished between worksheets, workbooks or files are 

dynamic, and changing the source value will lead 
to all those values reliant on the source value au-
tomatically being updated. Remember that when 
re-opening a file that creates a dynamic link, you 
will be asked whether you wish to update the file 
when it is opened or not.

42.3.4 Analysing and interpreting 
data
One of the biggest advantages of using spread-
sheet tools to help you to analyse data is that you 
can manipulate the data in many ways to give you 
different perspectives and help you to identify 
information that otherwise might be difficult to 
spot. The following section gives some examples.

Converting data
Creating charts in different formats from the same 
data can highlight unusual events.

Lists
These can be sorted – for example, sales values 
from particular representatives could be ordered 
highest to lowest at the touch of a button. This 
would show immediately the ranked order of suc-
cessful sales for staff.

Similarly the data could be filtered, to exclude any 
records that have a particular value.  One example 
would be to filter a stock table to show just those 
items that have a stock of fewer than 10 items (for 
reordering purposes).

Trends and patterns
Using charts, graphs, lists and so on, you should 
quickly be able to spot any trends or patterns in 
the data. Comparing year 1 sales with year 2 sales 
will show, for example, if a particular month shows 
high or low sales. In this instance, the data could 
then be interrogated to find out why that partic-
ular event occurred (was it the weather, was the 
product out of season, etc).

Data analysis and results
The data itself will be analysed in different ways, 
making use of different tools to produce the re-
sults of the analysis. At this stage no conclusion 
is drawn from this information – the data simply 
says that this is so and it is up to the data user (or 
spreadsheet user in some cases) to find the facts.

Figure 42.88  Pie chart without annotation
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Conclusions
Conclusions are now drawn – the data is inter-
preted and meaning is found in the results. This 
gets easier with experience. Although novice data/
spreadsheet users are unlikely to have to draw 
these conclusions, to learn how conclusions are 
drawn from information following a data analysis, 
ask the data user to share his or her conclusions 
with you.

42.3.5 Customisation
This section will cover the following grading 
criterion: 

P5

Restricting data entry 
Hiding columns and rows of data in a spreadsheet 
to prevent access by particular users is a simple 
procedure. 

Simply select the columns you wish to hide, then 
right click and choose Hide (this can be seen in 
Figure 42.89). The same technique is used for hid-
ing rows.

This will not prevent the user accessing them if 
needed. To Unhide, the user simply highlights the 
columns to the left and right of where the column 
or columns are missing, and then right clicks and 
chooses Unhide.

Protecting the contents of rows or columns re-
quires slightly reversed thinking! When protecting 
a whole sheet, the developer will simply click on 
the Home tab, then find the Cells submenu, and 
under the Protection options choose to Protect 
Sheet (see Figure 42.90).

Sheet protection can be safeguarded using a 
password, effectively locking the whole worksheet 
and preventing users from being able to change 
any values.

On more modern versions of Microsoft Excel®, 
however, it is now also possible to give specific lev-
els of worksheet access to users as can be seen in 
Figure 42.91.

Make the Grade
For P5 you will carry out further work on your 
spreadsheet model.  
	 In this instance you will need to use tools and 
techniques to customise the spreadsheet model. 
	 Examples of customisation include restricting 
data entry, for example hiding information, protecting 
worksheets and cells, modifying toolbars and menus, 
checking data, for example data validation, range 
checking, not NULL and displaying error messages.

P5

Figure 42.89  Hiding columns

Figure 42.90  Protecting the worksheet

Figure 42.91  Selecting protection
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The developer might, on the other hand, wish to 
protect the important parts of the spreadsheet, 
such as headings and totals, and only enable (or 
leave accessible) those areas that are safe for a 
novice user to use.

To do this the developer will need to unlock (make 
accessible) those areas that the user is free to ac-
cess, prior to protecting the worksheet.

In Figure 42.92, the area that the user will be able 
to key into has been identified.

If the user now right clicks on the identified 
cells, then clicks on Format Cells and finally on 
Protection, the dialogue box shown in Figure 
42.93 will become visible. The user unchecks the 
Locked box in order to unlock those cells when the 
rest of the sheet becomes protected.

You will also notice that cells to be hidden can be 
identified in the same way. 

Once the cells to be kept active have been un-
locked, the sheet is protected in the usual way (see 
Figures 42.90 and 42.91).

Modifying toolbars and menus 
Having already considered how data can be hid-
den or locked and how whole worksheets can be 
protected, you might also wish to limit the func-
tionality that a user has access to by removing 
buttons or menus.

Data validation, range checking and error 
messages
Customising your spreadsheet to provide some 
data validation functionality is essential to main-
tain the integrity of your data and some sugges-
tions for this activity have already been covered in 
section 42.2.1, including validation, range check-
ing and the use of customised error messages.

42.3.6 Automation
This section will cover the following grading 
criteria: 

P6
  

M3

Macros
Macros are mini programs that automate chosen 
functions in a spreadsheet. They can be stored 
within a particular workbook or stored globally so 
that they can be accessed by all workbooks.

Recording a macro is a very straightforward proc-
ess. You can either select the View tab and then the 
Macro submenu, or you can use the Developer tab 
which contains many of the macro functions. This 
is not visible by default and may need to be added.

To add the Developer tab, click on the Microsoft 
Office® icon, Excel® Options and check the box as 
shown in Figure 42.94.

Figure 42.92  Identifying the user access area

Figure 42.93  Unlocking cells

Make the Grade
For P6 you should develop the spreadsheet model 
further by implementing automated features, such 
as macros, ActiveX® controls, Control Toolbox or 
Microsoft Visual Basic®.
	 M3 builds on P6 by requiring you to compare 
different automation methods including macros, 
ActiveX® control, Control Toolbox and Visual Basic®.  
	 This can be most efficiently achieved by using a 
simple table of comparison.

M3P6

Figure 42.94  Adding the Developer tab
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When you click on the Developer tab, you can then 
choose to Record a new macro (Figure 42.95).

Figure 42.95  Recording a macro

As soon as Record New Macro has been selected, 
the dialogue box shown in Figure 42.96 will ap-
pear. Here you will have to give the macro a name, 
and you will select whether the macro will be vis-
ible to the workbook open at the time it was creat-
ed, a new workbook not yet created, or whether it 
should be placed in a Personal Macro Workbook. 
This is what effectively makes the macro global be-
cause the Personal Macro Workbook is visible to 
all spreadsheets. This is called ‘scoping’.

Once you click on OK, the macro will begin re-
cording and every action you undertake will be 
logged, until you click on the Stop Recording but-
ton as shown in Figure 42.97.

Once the recording has been stopped, you can 
then add a button to the spreadsheet to activate 
the macro.

To do this you must select the Developer tab, 
click on the Controls submenu, click on Insert 
and then from the Form Controls click on the 
button icon.

Draw a button on your spreadsheet and when you 
release the mouse the Assign Macro dialogue box 
will appear. Choose the macro you wish to assign.

You can also change the caption on the button to 
describe what the button does (e.g. Print).

Macros you might like to record to enhance your 
spreadsheet could include:

MM a print macro to always print a specific number 
of copies of a whole spreadsheet

MM a macro to select a specific area in a spread-
sheet for printing

MM a macro that ensures that all columns are of 
the correct width to accommodate the data

Figure 42.96  Scoping the macro

Figure 42.97  Stop recording

Figure 42.98  Adding a button

Figure 42.99  Assign a macro
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MM a macro that ensures that all numeric columns 
have two decimal places.

The list of possible options is extensive and would 
fill an entire book of its own! What you must en-
sure, however, is that you choose a macro that is 
going to be useful to the user, rather than just cre-
ating one to prove you can!

ActiveX® controls and Control Toolbox
These are objects that can be downloaded, writ-
ten by the spreadsheet developer or imported 
from other software applications and which can be 
made available to different programs as well as dif-
ferent files in the system.  

They can also be embedded into particular files 
to carry out pre-defined functions. These con-
trols are reusable and can be accessed through 
the ActiveX® Controls, More Controls option as 
shown in Figure 42.100. Some examples are shown 
in Figure 42.101.

Visual Basic® for Applications (VBA)
Visual Basic® is the programming language used to 
support automated processes in most Microsoft® 
applications. Shown below is the macro that was 
introduced earlier in this unit:

Amending the print range or the number of prints 
is achieved by simply changing the relevant values 
in the code:

42.4 Be able to test and 
document spreadsheet models
This section will cover the following grading 
criteria: 

P7
  

D2

Figure 42.100  Controls

Figure 42.101  ActiveX® options

Sub Macro1()
Macro1 Macro
Macro recorded 20/07/2010 by Bernie
    Range(“A1:A7,B3:B7”).Select                                 
‘Choose these ranges
    Selection.PrintOut Copies:=3, 
Collate:=True            ‘Print three 
copies
End Sub

Sub Macro1()
Macro1 Macro
Macro recorded 20/07/2010 by Bernie
    Range(“A1:A12,B3:B12”).Select                      	
‘Choose a different range
    Selection.PrintOut Copies:=6, 
Collate:=True             ‘Print six copies
End Sub

Make the Grade
For P7 you will need to check and test your 
spreadsheet to ensure that it is fit for purpose. 
You will test for accuracy and functionality 
and you will need to evidence that you have 
checked the spreadsheet model in terms of the 
required functionality, accuracy of calculations, 
data validation, and ensured that the results of 
calculations and so on, are displayed with an

D2P7
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appropriate level of detail (columns for example to 
two decimal places). Evidence should be in the form 
of test plans and screen captures.
	 D2 builds on P7 by requiring you to evaluate 
your spreadsheet model incorporating feedback 
from others. You should be able to reflect on your 
own performance in building a spreadsheet model 
and consider what hurdles you had to overcome 
to achieve the desired result. Questions you should 
pose to focus the evaluation could include: 

MM Did the spreadsheet model meet the given 
requirements? 

MM What did other people think of the spreadsheet 
model? 

MM Was there any functionality that could be  
included or aspects that could be improved?

Reviewing the answers to these questions will also 
enable you to include some sensible  
recommendations for improvements.

42.4.1 Test
There are three main reasons for testing your 
spreadsheet. This would be to:

a.	 confirm the spreadsheet has the correct 
functionality

b.	confirm the spreadsheet calculations and so on 
are correct

c.	 confirm the spreadsheet is simple to use (short-
cuts, data forms etc.).

Formulae and functions 
Those formulae and functions created by the 
spreadsheet developer need to be carefully checked.

Formulae, for example, should be checked to make 
sure that they include all the values in a range. 
The order of precedence in any formulae should 
also be checked (don’t forget that incorrect use of 
BODMAS will still give an answer, it just won’t be 
the right answer).

Similarly, any functions should be checked care-
fully, using manual methods to confirm the an-
swers (the use of pen, paper and calculator is the 
most common)!

Data entry forms
The checks on data entry forms will largely consist 
of visual checks of the following:

MM completeness  
MM presence of all the required functionality

MM that the tab order of any inputs follows the 
natural progression of any input forms

MM that any user prompts are complete and in 
place

MM spelling of any labels.

Validation
Validation routines should be checked to ensure 
that good values are accepted and that bad val-
ues are rejected, with the correct error message 
displaying as needed.  

Collecting or creating relevant test data is covered 
in the next section.

Layout
Firstly, columns should be made wide enough to 
accommodate all headings and the numbers them-
selves. If columns are not wide enough to accom-
modate the data within them, the numbers are 
shown as hashes. Widening the column will bring 
the actual values back into view (Figure 42.103).

Values
As part of the development of a spreadsheet, the 
results of calculations should also be carefully 
checked. Using alternative means of calculating 
the answers, such as a pen and paper or a calcu-
lator, is necessary to test the spreadsheet formally 
and thus ensure that formulae and functions are 
working as they should.

In addition, developers need to make decisions 
about the level of detail required in the numbers 
that are displayed.

With spreadsheets containing British currency, 
for example, there may be little point in displaying 
numbers to three decimal places – £15.947 – be-
cause no physical currency exists for 0.7 of a pence. 

Figure 42.102  Spreadsheet showing missing data 
hashes
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On the other hand, there will be instances where 
it is appropriate to display values to five or more 
decimal places (e.g. scientific measurements).

Suitability for client
Although your tutor may not be a paying customer, 
he or she is still the person for whom the spread-
sheet is being created.

Clearly it is necessary to ask him or her for feed-
back on the suitability of the final solution. This 
process can be formalised (maybe with a feedback 
interview), but will more likely involve user testing 
(see below).

User testing
If the spreadsheet is going to be used by one or 
more users, you would ordinarily ask the users to 
test it. This can be very useful for checking the ro-
bustness of the spreadsheet. For example, if you 
have error trapping to trap incorrect numeric val-
ues, have you tested it by inputting a character or 
symbol? A real user could very easily make these 
kinds of mistakes!

Usually the user is given a form or some sort of 
feedback document to complete.

Test plans using normal, extreme and 
erroneous data
Data selected for testing purposes should cover 
the following range:

MM Normal data – the program needs to be tested 
with data that is within a sensible range. This is 

the data that is expected to be input when the 
system is being used normally.

MM Extreme data – the program should also be 
tested with data that, though still within a 
sensible range, is less likely to be input. For 
example, an age over 115 is not impossible, it’s 
just unlikely!

MM Erroneous data – this is data that is neither 
normal nor sensible! It is data that is blatantly 
incorrect. The data will contain values outside 
valid ranges and incorrect types of values 
(e.g. characters where numbers are expected 
and vice versa).

42.4.2 Feedback
Receiving feedback for any IT project is essential 
to ensure that a) the client or user is happy that 
he or she is getting the expected solution and b) 
there is confirmation that the system works as  
it should.

The methods used for obtaining feedback in this 
situation tend to be surveys, questionnaires and 
interviews. As these techniques support the inves-
tigation phase of the systems life cycle, they are 
explained in full in Unit 11 section 11.2.1.

Analyse results and make recommendations
Once received, feedback should be carefully col-
lated and analysed and any errors or problems 
fixed in the short term. In the medium term, any 
additional functionality could also be added to 
improve the spreadsheet.

Activity 6

Complete the following test plan to reflect testing for normal, extreme and 
erroneous data. In each case, suggest at least two values!

Test Normal data Extreme Data Erroneous data

Age is between 18 and 21

Height is between 1.5 and 2.2 metres

Quantity (must not be 0)

Price (must be more than 0, but less than 
£20.00)

Choice must be A, B, C, D or E

Hours worked (must be greater than 0, 
but less than 50)
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42.4.3 Alternative formats
This section will cover the following grading 
criterion: 

P8

	 In addition, you will have a copy of the original 
file and the converted file and to fully evidence the 
criterion, you could open the converted file and send 
it to print.

For the occasions when you might want to export an 
entire spreadsheet file, Microsoft Excel® offers you 
the opportunity to save the files in different formats.  
To save in a different format, you merely need to 
choose a different file type when going through 
the Save As… dialogue.
A range of common formats is explored in Table 
42.03.
Remember that each of the formats will present 
the file in the file management system with a dif-
ferent icon.
What you should notice is that as the file exten-
sions are different for each format, the file name 
can actually remain the same!

Make the Grade
A practical task, the P8 criterion requires you to 
export the contents of a spreadsheet model to an 
alternative format. This does not necessarily mean 
that you need to export the entire contents of a 
spreadsheet, but you will need to choose a sensible 
section of the spreadsheet and save it as a smaller 
file if you decide not to export the whole thing.
	 When the conversion is carried out, a witness 
statement could be used to record the activity.  

P8

Table 42.03

Format choice Description

xls An eXceL Spreadsheet and the default format applied when you save a spreadsheet in 
Microsoft Excel 97~2003®.
This format is still supported in newer versions of Microsoft Excel®.

csv This stands for comma separated value. If you save a spreadsheet in this format, the cells 
are separated by commas, and a new line denotes the beginning of a new line in the 
spreadsheet.
The spreadsheet in Figure 42.104 is saved in xls format. 

Figure 42.103  .xlsx format
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Format choice Description

csv If the file is now been saved as a .csv file and imported into Microsoft Word®, it will look 
like this: 

txt This format is a simple text file. The same ice cream sales data has now been saved in this 
format and the new file imported into Microsoft Word®. This is how the content of the file 
looks now:

In this instance, the commas are missing and an attempt has been made by the software to 
align the information using default tabs. Text files are perhaps the most flexible and most 
basic format to save data because the majority of applications and operating systems will be 
able to read them.

pdf This popular format will enable the user to export the spreadsheet as an Adobe Acrobat® 
portable document format file, to be read with the freely downloadable Adobe Acrobat 
Reader® application. 

xlsx An eXceL Spreadsheet XML workbook and the default format applied when you save a 
spreadsheet in Microsoft Excel 2007®.

html The hypertext markup language format option prepares the data to be used in the creation 
of web pages, exporting it in a web browser-friendly format.

Figure 42.104  .csv format

Figure 42.105  .txt format
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42.4.4 Documentation
This section will cover the following grading 
criteria: 

P9
  

M4

In order to make sure that any IT solution can 
be properly maintained (repaired if problems 
arise or enhanced if new functionality is needed) 
a range of documentation will need to be created 
that explains the solution from a number of per-
spectives. The same will be true for a spreadsheet 
solution. The documents created may be printed, 
could be held electronically in a .doc file, or as a 
series of web pages for users to access when need-
ed (e.g. on an organisation’s intranet).

User documentation
This documentation should be developed from a 
user perspective. It should contain: 

MM a guide on the overall purpose of the 
spreadsheet

MM instructions on how to use the spreadsheet, in 
particular how to execute specific tasks

MM troubleshooting information on what the user 
should do if the spreadsheet does not function 
correctly. 

Technical documentation
The technical documentation may be a section in 
the user documentation or could be a completely 
separate document or series of web pages. This in-
formation will focus on:

MM Hardware resources – this will usually specify 
any particular hardware requirements that are 
needed to run the spreadsheet successfully.

MM Software resources – it is likely that the 
spreadsheet solution will have been created 
in a particular version of Microsoft Excel® and 
this should be recorded. This is because the 
spreadsheet might not be compatible with ear-
lier versions of the software.

Instructions
Although modern software largely has electronic 
help files, many people still prefer books to sup-
port the general use of software. The following 
URL provides a link to a series of Microsoft Excel® 
books that can be purchased on www.amazon.
co.uk:  

http://www.amazon.co.uk/s/ref=nb_sb_
noss?url=search-alias%3Dstripbooks&field-
keywords=excel&x=14&y=17&fsc=-1

Calculations
All calculations and functions used or created 
should be recorded. With spreadsheet solutions 
it is useful if the holding cell (cell where the for-
mula is written), the formula itself and a descrip-
tion of the formula or function is included (a print 
of the spreadsheet in formula view could also be 
included).

Formula

Cell A15    =A14*20%  �	   This formula 

	 calculates VAT.

Functions used

Cell A14    =SUM(A1:A13)	� This function adds  
together the values 
on the invoice to 
provide a pre-VAT 
subtotal.

To display the formula view of a spreadsheet, click on 
the Formula tab, then on the Formula Editing sub-
menu choose Show Formulas (see Figure 42.106).

Make the Grade
For P9 you will need to produce user documentation 
with instructions for users on how to use the 
spreadsheet model, especially when navigating the 
user interfaces. This can be achieved as a formal 
document or equally as a series of web pages.
	 M4 builds on P9 by requiring you to add  
technical documentation, which includes the 
required hardware and software resources, 
instructions and an explanation of calculations 
used in the spreadsheet model.  
	 Again this could be a completely separate 
document or could be additional pages in a web-
based help file. Screencast videos (see Unit 6, 
section 6.2.1 ‘Writing documentation’) could also be 
used.

M4P9
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On the View tab click the Formulas checkbox in 

On the view tab click the Formulas Checkbox in 
the Window options section. The screen will now 
appear as shown in Figure 42.107.

Validation procedures
All validation routines and procedures should be 
recorded, stating what the validation routine is set 

to check and annotating any error messages that 
will be displayed.  

Macros and Visual Basic® code
All macros and Visual Basic® code should be de-
scribed and annotated with simple comments that 
tell the reader what the line of code does (rather 
than describing the actual commands used).

The key to working successfully with spreadsheets 
is to make any spreadsheet solution look profes-
sional, make sure it is as efficient as possible and 
check that any calculations, validation and macros 
work correctly.

Figure 42.106  Show Formulas

Figure 42.107  Formula view

Sub Macro1()             ‘Print Macro 
for Sales Report
‘Macro1 Macro  
‘Macro recorded 20/07/2010 by 
Bernie
    Range(“A1:A7,B3:B7”).Select                               
‘Chooses the range to print
    Selection.PrintOut Copies:=3, 
Collate:=True          ‘Specifies the 
number of copies
End Sub
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Further reading
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0764597809

Hart-Davis, G. – How to Do Everything with 
Microsoft Office Excel 2003 (McGraw-Hill 
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Websites
www.office.microsoft.com/en-us/excel/default.aspx

www.support.openoffice.org/index.html
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In order to achieve each unit, you will complete 
a series of coursework activities.  Each time you 
hand in work, your tutor will return this to you 
with a record of your achievement.

This particular unit has 15 criteria to meet: 9 
Pass, 4 Merit and 2 Distinction.

For a Pass: You must achieve all 9 Pass criteria.

For a Merit: You must achieve all 9 Pass and all 
4 Merit criteria.

For a Distinction: You must achieve all 9 Pass, 
all 4 Merit and both Distinction criteria.
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